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Aims and scope: Biofuels

As global energy requirements change and grow, it is crucial that all aspects of the
bioenergy production process are streamlined and improved, from the design of more
efficient biorefineries to research into biohydrogen as an energy carrier. Current energy
infrastructures need to be adapted and changed to fulfil the promises of biomass for
power generation.

Biofuels provides a forum for all stakeholders in the bioenergy sector, featuring review
articles, original research, commentaries, news, research and development spotlights,
interviews with key opinion leaders and much more, with a view to establishing an
international community of bioenergy communication.

As biofuel research continues at an unprecedented rate, the development of new
feedstocks and improvements in bioenergy production processes provide the key to the
transformation of biomass into a global energy resource. With the twin threats of climate
change and depleted fossil fuel reserves looming, it is vitally important that research
communities are ealize d to fully ealize the potential of bioenergy.

Principal themes include:

e Sustainable production of annual, perennial and woodfeedstocks from agriculture

e Creation of new biomass feedstocks in laboratories

e Biochemical conversion techniques

e TFermentation, anaerobic digestion and enzymedevelopment

e Thermochemical conversion techniques

e Biocatalyst development, gasification and pyrolysis plants

e Bioenergy systems and plant engineering

e Conversion of biomass into heat, electricity and biohydrogen

e Storage and transportation of biomass during manufacture

e Implementation, improved efficiency and reducedenvironmental impact of first
generation biofuels, includingethanol and biodiesel

e New bioenergy sources: algae, genetically engineered fuels,and biochemical
carbon dioxide conversion

e Policy, management and communication to establish aglobal bioenergy market
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Aims and scope: Carbon Management

Carbon Management provides an international peer-reviewed forum for current insights
from the diverse array of disciplines working to enhance our understanding of carbon
interactions — from biology, ecology, chemistry and engineering to law, policy, economics
and sociology.

Carbon Management examines the mechanisms by which we can both manage current
GHG levels and reduce future emissions effectively, to mitigate climate change. The
journal covers opportunities for carbon management throughout the whole carbon cycle,
including technological and engineering innovations for carbon sequestration, as well as
the role of natural processes. Plans aimed at managing and reducing emitted carbon, such
as carbon accounting initiatives, also feature.

The core scientific research and review content of each issue is augmented by news,
editorials, interviews and policy updates presenting enlightened opinion and commentary
on pressing and topical issues. The journal’s diverse content reflects the range of
expertise and innovative enquiry essential to remain at the forefront of this rapidly
emerging field.

Decisions made in the near future will have profound consequences on the impact of
carbon management for decades to come. Carbon Management delivers a synthesis of the
latest findings relevant to those working in the fields of research, education, management
and environmental policy. It provides detailed information in an accessible format,
serving as an essential reference to inform future decisions.

Principal themes include:

e Carbon accounting initiatives, including carbon footprinting and emissions
trading

e Validation of emissions data and measurement techniques

e Modeling of carbon emissions and management scenarios for multiple climate
stabilization targets

e Policy developments to regulate and incentivise reductions in carbon emissions

e Market-based mechanisms of emission reductions

e Management processes at local, regional and national levels

e The impacts of anthropogenic activities on carbon emissions, including: energy
and waste management; transport and trade; business, industry and domestic;
buildings, construction methods and urbanization; farming, agriculture and food
production; deforestation and forestry practices

Audience

The audience for Biofuels and Carbon Management consists of:

e Academics

e Industry professionals

e [Laboratory personnel

¢ Economists

e DPolicy & decision makers
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e Bioenergy stakeholders
e Non-governmental organizations

Future Science articles have been engineered specifically for the time-constrained
professional. The structure is designed to draw readers’ attention directly to the
information they require.




At-a-glance article formatting checklist
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Authors should consult the below checklist before formatting their manuscript. Further
details on all article sections are given in ‘Article Sections’.

Sections Word Abstract | Defined Key Future Reference Figures and Supporting
count key words Perspective limit tables cover letter
range terms and permitted

(excluding Executive

abstract and Summary

references)
Article type
Editorial 1000-1500 X X % X 20 X X
Opinion 1000-1500 X Fd %4 X 20 X X
Policy Update | 1000-1500 X X v X Tables only F
Commentary | 1500-3000 X X v X 20 X X
Letter to the | 1500 X X X X 20 X X
Editor
Conference 1000-3000 v X X X 20 v X
Report
Research 1500-2000 4 X X v 20 One of each only X
Spotlight
Special Report | 3000-5000 v v X 4 50 v X
Case Study 3000-5000 v 4 X v 50 v X
Perspective 4000-8000 v v X %4 150 v X
Policy Focus | 4000-8000 v v X 4 150 v X
Review 4000-8000 v v X v 150 v X
Technology/P | 4000-8000 v v X v 150 v X
atent Review
Research 5000-8000 v 4 X 4 150 v v
Article
Preliminary 3000-5000 v v X v 50 v v
Communicati
on
Methodology | 3000-5000 v v X v 50 v v
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Article types

Biofuels and Carbon Management publishes a range of article types, descriptions of which
are outlined below. Authors are encouraged to consult the ‘article formatting checklist’
for details on word counts and other formatting requirements.

Editorials, Opinions and Commentaries

Editorials are short articles that provide an insight into, or snapshot of issues of topical
importance to the journal’s target audience or researchers and other professionals. The
intention is that the article should offer an expert perspective on a topic of recent
interest. More detailed discussions can take the form of Commentary articles.

Opinion articles should typically be informed, agenda-setting and authoritative. If
addressing a problem, they should also present coherent argued solutions. They can
address issues relating to scientific research, or peripheral areas of debate affecting
industry and academia of concern to the journal’s scope.

Published examples:

Sexton S, Zilberman D. Beyond the ‘food or biofuel’ dilemma. Biofuels 2(4) 361-363.
www.future-science.com/doi/pdf/10.4155/bfs.11.111

Kejun J. Secure low-carbon development in China. Carbon Management 3(4) 333-335.
www.future-science.com/doi/pdf/10.4155/cmt.12.42.

Policy Updates

Policy Updates are short opinion-based articles. Authors are given the opportunity to
discuss important advances in policy of topical relevance to the journal. We encourage
our writers to express their opinions, and discuss the future implications of the policy
issues under consideration.

Published examples:

de Gorter H, Drabik D. Biofuel policies and grain crop price volatility. Biofuels 3(2) 111-
113.
www.future-science.com/doi/pdf/10.4155/bfs.12.2

Jotzo F. Will Australia be a major buyer in international carbon markets? Carbon
Management 3(4) 345-347.
www.future-science.com/doi/pdf/10.4155/cmt.12.44

Conference Reports

Conference reports aim to summarise the most important research presented at a recent
relevant meeting or event. It is not usually feasible to attempt comprehensive coverage of
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the conference; authors should therefore focus on those presentations that are most
topical, interesting or thought-provoking.

Published examples:

Long Y-D, Fang Z. World Congress of Bioenergy, 2012: renewable energy for
sustainability. Biofuels 3(4) 377-378
www.future-science.com/doi/pdf/10.4155/bfs.12.37

Gale J. International Conference on Greenhouse Gas Control Technologies 10: from
research to reality Carbon Management 1(2) 187-189
www.future-science.com/doi/pdf/10.4155/cmt.10.31

Research Spotlights

Research spotlights allow representatives from institutions, manufacturers,
universities, research groups to describe the work currently being carried out within their
particular organization, relevant to the field of the journal in question.

Published example:

Stanley M, MacDonald J, Jenkins T. Algal bioenergy, ecosystem services and the Algal
Bioenergy Special Interest Group. Bigfuels 3(3) 255-258.
www.future-science.com/doi/pdf/10.4155/bfs.12.16

Reviews

Reviews aim to highlight recent significant advances in research, ongoing challenges and
unmet needs; authors should be concise and critical in their appraisal of the subject
matter, and strive for clarity. The focus should be on key, defining developments rather
than providing a comprehensive literature survey. Reviews should provide balanced
coverage of the field and not focus predominantly on the authot's own research. Authors
are encouraged to include their own perspective on current trends and future directions.

Published examples:

Hildebrand M, Davis AK, Smith SR, Traller JC, Abbriano R. The place of diatoms in the
biofuels industry. Bigfuels 3(2) 221-240
www.future-science.com/doi/pdf/10.4155/bfs.11.157

Achard A, Stibig H-J, Eva HD e7 a/.Estimating tropical deforestation from Earth
observation data. Carbon Management 1(2) 271-287
www.future-science.com/doi/pdf/10.4155/cmt.10.30
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Perspectives

Perspectives have the same basic structure and length as review articles; however, they
should be more speculative and forward-looking, even visionary. They offer the author
the opportunity to present criticism, address controversy or provide a personal angle on a
significant issue. Authors of perspectives are encouraged to be opinionated, with all
positions concisely and clearly argued and referenced. Referees will be briefed to review
these articles for quality and relevance of argument only. They will not necessarily be
expected to agree with the authot’s position.

Published examples:

Colosi LM, Zhang Y, Clarens AF, White AF. Will algae produce the green? Using
published life cycle assessments as a starting point for economic evaluation of future
algae-to-energy systems. Biofuels 3(2) 129-142.
www.future-science.com/doi/pdf/10.4155/bfs.12.4

Goetz S, Dubayah R. Advances in remote sensing technology and implications for
measuring and monitoring forest carbon stocks and change. Carbon Management 2(4) 231—
244,

www.future-science.com/doi/pdf/10.4155/cmt.11.18

Policy Focus

Policy Focus articles aim to highlight recent significant advances in policy, as well as
ongoing challenges and unmet needs. Policy Focus articles should take the same format
as a typical Review article, but the content should have a significant emphasis on issues
related to policy. Authors should strive for brevity and clarity. Each article should
concentrate on the most recent developments and should aim for a concise presentation
of relevant information.

Published examples:

McCormick K, Bomb C, Deurwaarder E. Governance of biofuels for transport in
Europe: lessons from Sweden and the UK. Bigfuels 3(3) 293-305.
www.future-science.com/doi/pdf/10.4155/bfs.12.15

Chaturvedi RK, Gopalakrishnan R, Sukumar R, Ravindranath NH. Carbon management
in Indian forests: a policy analysis to assess mitigation potential. Carbon Management 1(1)
109-117.

www.future-science.com/doi/pdf/10.4155/cmt.10.19
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Special Reports

Special reports are short review-style articles that highlight a particular niche area, be it a
specific emerging field, novel hypotheses or method. Articles are categorised as Special
Reports at the discretion of the Editorial team.

Published examples:

O’Connell D, Haritos VS. Conceptual investment framework for biofuels and
biorefineries research and development. Biofuels 1(1) 201-216.
www.future-science.com/doi/pdf/10.4155/bfs.09.14

Williams I, Kemp S, Coello J, Turner DA, Wright LA. A beginner’s guide to carbon
footprinting. Carbon Management 3(1) 55—67
www.future-science.com/doi/pdf/10.4155/cmt.11.80

Case Studies

Case Studies are short report-style articles that use a specific case example, regionally or
nationally, to illustrate a theory or introduce a new standard for future reference. Case
studies should be focused on a specific emerging field, novel hypotheses or evolving
method. Articles are categorised as Case Studies at the discretion of the Editorial Team.

Product and Technology Reviews

Product and Technology Reviews are review-style articles that summarise selected
instrumentation, techniques or software. The article should clearly highlight the relevance
of the products or technology to environmental science and present an objective
perspective on the product(s) under discussion.

Patent Reviews

Patent Reviews should provide an objective and concise appraisal of a selection of
patents in a chosen area. Discussions should be placed within the context of the relevant
wider R&D landscape. Authors are expected to offer a commentary on the significance,
potential and essential content of the patents under discussion. The patents reviewed
should be from a variety of companies/assignees, and should be timely (Ze. ideally
granted within the past 1-4 years). The majority of the references cited in the article
should be taken from the patent literature. Patent Reviews should provide balanced
coverage of the field and not focus predominantly on the author's own research. Where
the controversial or novel ideas are presented, opposing viewpoints should be briefly
mentioned and appraised. Authors are encouraged to include their own perspective on
current trends and future directions.

A separate detailed set of guidelines for writing patent reviews is available here.

Research Articles

Authors of original research must provide a supporting Cover Letter on submission
briefly detailing:

e relevance to the journal’s audience;
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e where the novelty in the study lies;
e direct and potential implications of the findings.
Experimental details and data

Only where a novel experimental procedure has been employed full details must be
provided, such that a skilled scientist would be able to reproduce the results presented.
Details of routine or previously reported experimental procedures should be provided via
references only.

Experimental procedures and/or data running to more than two Word document pages
should be placed in a supplementary information file.

Published examples:

Corbett JJ, Winebrake JJ, Green EH. An assessment of technologies for reducing
regional short-lived climate forcers emitted by ships with implications for Arctic
shipping. Carbon Management 1(2) 207-225.
www.future-science.com/doi/pdf/10.4155/cmt.10.27

Cetinkol OP, Dibble DC, Cheng G ¢ a/. Understanding the impact of ionic liquid
pretreatment on eucalyptus. Biofuels 1(1) 33—40.
www.future-science.com/doi/pdf/10.4155/bfs.09.5

The journal publishes three categories of research article:

Research Article

Research articles should present novel work that makes a significant impact within the
scope of the journal, and which represents an important advancement in knowledge or
understanding. Routine or incremental work is not suitable for full research papers.
Research should be reported succinctly; the inclusion of detailed background discussion
is to be avoided. Supporting data or further experimental details can be submitted as
Supplementary Information. If requested by the Editor or reviewers, authors should be
able to provide additional relevant original data underpinning their research.

Preliminary Communications

Preliminary communication articles are intended for short reports of studies that present
promising improvements or developments on existing areas of research. The significance
and potential implications of the developments must be explicit.

Methodologies

Methodology articles should provide an overview of a new experimental or
computational method, test or procedure. The method described may be either
completely novel, or may offer a demonstrable improvement on an existing method. The
significance and potential implications of the developments must be explicit.

Letters to the Editor

Readers may submit Letters to the Editor, commenting on an article published in the
journal. Where appropriate, Letters to the Editor will be sent to the author of the original
article, who will have 28 days to provide a response for publication. Acceptance of
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Letters to the Editor for publication is at the discretion of the Editor and Editorial
Board.

Article sections

The following list provides notes on the key article sections; authors should consult the
article formatting checklist to determine which sections are required for their
submission.

Title: Concisely and cleatly conveys the scope/novelty of the article; not more than 120
characters.

Author(s) names and affiliations: Including full name, postal address, phone and fax
numbers, and e-mail address.

Abstract: Not more than 120 words; no references should be cited in the abstract. The
abstract should highlight the importance of the field under discussion within the journal’s
scope, and clearly define the parameters of the article.

For all Research Articles only, the abstract must be structured into three sections:

o Background: Brief overview of the context, purpose and novelty of the
study. Discussion of background science should be kept be kept to a
minimum.

o Results/Methodology (as appropriate): a succinct summary of the
experimental procedure and key findings; detailed experimental data or
explanations of experimental procedures should be submitted as
supplementary information.

o Conclusions: A summary of the main conclusions of the study and any
implications for the field.

Author photographs: Required for Editorial, Opinion and Policy Update articles only.
The corresponding author plus one other author, if desired, can provide a suitable high-
resolution head shot for inclusion.

Key words: Required for Editorials, Opinions, Commentaries and Policy Updates
only; a selection of 5-10 words that encapsulate the scope of the article.

Defined key terms: Required for Reviews, Perspectives, Policy Focus and Original
Research only; 5-10 key technical terms or concepts that are mentioned in the text for
which a short definition or explanation is provided. Key terms enhance the article by
providing supplementary or background information and should not repeat details
already given in the text. When choosing key terms, authors should consider the
readership of the journal and avoid the inclusion of rudimentary definitions.

Body of the article: The article content should be arranged under relevant headings and
subheadings to assist the reader.

Future perspective: A speculative viewpoint on how the field will evolve in 5-10 years’
time.
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Executive summary: Bulleted summary points that illustrate the main conclusions
made throughout the article.

Figures, tables and boxes

The use of figures and diagrams is encouraged wherever relevant. The author should
include illustrations and tables to condense and illustrate the information they wish to
convey. Commentary that augments an article and could be viewed as ‘stand-alone’
should be included in a separate box. All figures, tables and boxes should be submitted in
an editable format.

Figures, tables and boxes should be numbered consecutively according to the order in
which they have been first cited in the text. All abbreviations used within them should be
defined in the legend.

If any of the figures or tables used in the manuscript requires permission from the
original publisher, it is the author’s responsibility to obtain this. More details on obtaining
permissions can be found in here and in the copyright section below.

Supplementary information

Tables, figures and boxes larger than one A4 page will be included as online-only
supplementary information. At the Editor’s discretion data or experimental details can
also be included.

References

o Authors should focus on recent papers; those older than 5 years should not be
included except for an over-riding purpose.

o References should be denoted numerically and in sequence in the text, using
Arabic numerals placed in square brackets, i.e., [12].

o If websites or patents are included, please use a separate numbering system for
them, ie., start numbering patent references at [101] and websites at [201] to
allow the reader to distinguish between websites/patents and primary literature
references both in the text and in the bibliography.

o Any references that are cited in figures, tables or boxes that do not appear in the
text should be listed at the end of the reference list in the order they occur.

Reference formatting

All references should be formatted according to the house style given in the below
examples:
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Journals:
Richards KR, Huebner GE. Evaluating protocols and standards for forest carbon offset

programs, Part B: leakage assessment, wood products, validation and verification. Carbon
Management 3(4), 411-425 (2012).

Journal supplements:

Grattan SR, Benes SE, Peters DW, Diaz F. Feasibility of irrigating pickleweed (Sa/icornia
bigelovii. Torr) with hyper-saline drainage water. |. Environ. Qual. 37Suppl. 5) $149-156
(2008).

Books:

Post W, Amonette J, Birdsey R e¢7 a/ Terrestrial biological carbon sequestration: science
for enhancement and implementation. In: Carbon Sequestration and lts Role in the Global
Carbon Cycle, V'olume 183. McPherson BJ, Sundquist ET (Eds). American Geophysical
Union, Washington, DC, USA, 73-88 (2009).

Meeting abstracts:

Benson TJ, Miquez MS, Holmes WE, French WT, Hernandez R. Development of an
ideal hydrotreating catalyst for the conversion of phospholipids to biofuels. Presented at:
21st International Symposium on Chemical Reaction Engineering. Philadelphia, PA, USA, 13-16
June 2010.

Patents:
Dubois JL. W0O090294 (2008).
Golubkov A, Golubkov 1. US7014668 (20006).

Please use the following formats for patent numbers issued by the World, US and
European patent offices, respectively: WO1234567, US1234567, EP-123456-A.

Reference annotations

Authors can highlight 6—8 references that are of particular significance to the subject
under discussion as “* of interest” or “** of considerable interest”, and provide a brief
(1-2 line) synopsis.

Example:

24  Nygren E, Aleklett K, Hook M. Aviation fuel
and future oil production scenarios. Energy
Policy 37(10), 4003-4010 (2009).

n  Important paper that highlights the
inconsistency of projections for aviation
expansion and the reality of the limited
supply of Jet A sources based on refinery and
crude oil availability. It highlights an
additional factor for the potential

importance of biofuels for aviation.
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Reference Manager style

1. Download the Future Science Reference Manager Style here.

2. Once the file is downloaded to your desktop, copy the file to the appropriate folder in
your program directory (usually located in C:\Program Files\Reference Manager\Styles).

EndNote style
Follow the instructions that are appropriate for your version of EndNote as listed below:
Installing the style into EndNote X2 and later versions

1. Download the Future Science EndNote style for references here (compatible with Mac
EndNote 9).

2. In Windows, or using your Macintosh Finder, browse to the location where you
downloaded the style. Double-click on the style file to open it. It should open in the
EndNote program.

3. In EndNote, go to the "File Menu" and choose "Save as."

4. Remove the word "copy" from the end of your style's name, and then click the Save
button.

5. Click on the "File Menu" and choose "Close Style."
Installing the style into EndNote 8, 9, X, or X1

1. Download the Future Science EndNote style for references here (compatible with Mac
EndNote 9).

2. Using Windows, or using your Macintosh Finder, browse to the location where you
downloaded the style. Right-click on the style file and select Copy.

3. Browse to your Endnote Styles folder. This will typically be in following location:
Windows: C:\Program Files\EndNote #\Styles (Where # is the version number for
EndNote)Mac OS: Applications\EndNote #\Styles (Where # is the version number for
EndNote)Note: If you modify the EndNote preferences, you can set this to another
location. To check this setting, go to the "Edit" menu or EndNote menu on the Mac and
select "Preferences.” Click on the Folder Locations option to see the custom Style folder
location and modify as needed. Keep in mind that the default location for the Styles
folder may cause problems when trying to save or edit in Windows Vista and 7 with
versions prior to EndNote X2. Please see this article for more information on this issue.

4. Right-click in this folder and choose Paste. Your style should now be installed in the
EndNote program.

If you require further assistance or have any questions, please contact the Editor.
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Chemical and biological structures

Authors should submit chemical structures in ISISDraw or Chemdraw formats. Please
use the following conventions:

e Always indicate stereochemistry where necessary — use the wedge and hash bond
convention for chiral centers and mark cis/trans bonds as such;

e Draw small peptides (up to five amino acids) in full; use amino acid abbreviations
(Gly, Val, Leu, etc.) for larger peptides;

e Refer to each structure with a number in the text.

Displaying 3D structures in online version of
article

The journal website has functionality to support the Jmol viewer for the display of
dynamic, 3D chemical and biological structures. We encourage authors to submit their
relevant figures in any of the file formats supported by Jmol - including as MOL and CIF
- to take advantage of this on-line functionality. More information on Jmol and the files
supported by it, can be found here: http://jmol.sourceforge.net/

A published example can be viewed here: http://www.future-
science.com/doi/suppl/10.4155/fmc.10.282/suppl file/figure6.htm

For more guidance, please contact the Editor.

Copyright

If a figure or table has been published previously (even if you were the author),
acknowledge the original source and submit written permission from the copyright
holder to reproduce the material where necessary.

As the author of your manuscript, you are responsible for obtaining permissions to use
material owned by others. Since the permission-seeking process can be remarkably time-
consuming, it is wise to begin writing for permission as soon as possible.

Future Science is a signatory to the STM Permissions Guidelines produced by the
International  Association of Scientific, Medical and Technical Publishers
(http://www.stm-assoc.org/). Permission is, or in the case of an express permission
requirement should be, granted free of charge by signatory organizations, with respect to
a particular journal article or book being prepared for publication, to:

* Use up to three figures (including tables) from a journal article or book chapter,
but:


http://jmol.sourceforge.net/
http://www.future-science.com/doi/suppl/10.4155/fmc.10.282/suppl_file/figure6.htm
http://www.future-science.com/doi/suppl/10.4155/fmc.10.282/suppl_file/figure6.htm
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not more than five figures from a whole book of journal issue/edition;
not more than six figures from an annual journal volume; and
not more than three figures from works published by a single publisher
for an article, and not more than three figures from works published by a
single publisher for a book chapter (and in total not more than thirty
figures from a single publisher for re-publication in a book, including a
multi-volume book with different authors per chapter).
* Use single text extracts of less than 400 words from a journal article or book
chapter, but not more than a total of 800 words from a whole book or journal
issue/edition.

Permission to go beyond such limits may be sought although in such instances the
permission grant may require permission fees. Important: although permission may be
granted without charge, authors must ensure that appropriate permission has
nevertheless been obtained. Co-signatories of the permissions agreement can be found
on the following website: http://www.stm-assoc.org/ stm-permission-guidelines/ .

Please send us photocopies of letters or forms granting you permission for the use of
copyrighted material so that we can see that any special requirements with regard to
wording and placement of credits are fulfilled. Keep the originals for your files. If
payment is required for use of the figure, this should be covered by the author.




